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MagVector™ MV2 3-axis magnetic sensor 

1- Overview 

1-1 FEATURES 

Measures total field: 3-axis 

Selectable measurement ranges: 
from 100 mT to 30 T 

Low noise: 300 nT/√Hz 

Supply voltage: 3.3 V or 5 V 

Analog and digital interfaces 

Selectable measurement rate: up to 3 kHz  

Selectable resolution: 14 to 16 bits 

Non-magnetic package 

1-2 SAMPLE APPLICATIONS 

High performance embedded applications 

Custom multi-probe field mappers 

Magnetic flux leakage measurement 

1-3 GENERAL DESCRIPTION 

The MagVector™ MV2, designed and manufactured by MPS Tech Switzerland 
(formerly Sensima Technology) in Gland, Switzerland, is a robust 3-axis magnetic 
Hall effect sensor. It features an analog as well as digital interface, selectable by 
the user. The analog mode delivers voltages proportional to the magnetic field, 
and the measurement range is configurable via simple wiring. In the digital mode, 
the MagVector MV2 communicates through a Serial Peripheral Interface (SPI) for 
configuration and data delivery. The non-magnetic QFN package is compatible 
with MRI environments. 

 

Figure 1. Block diagram  
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MagVector™ MV2 3-axis magnetic sensor 
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MagVector™ MV2 3-axis magnetic sensor 

3- General 

3-1 PACKAGE DIMENSIONS AND MARKING 

Package: 16L QFN 3x3x0.9mm, 0.50mm pitch with exposed pad of 1.70x1.70mm 

 

NOTES: 

All dimensions are in mm. 

Package dimensions do not include mold flash, protrusions, burrs or metal 
smearing. 

Co-planarity applies to the exposed terminals. Maximum co-planarity shall be 
0.08. 

Compliant with JEDEC-220. 

Marking: 3 lines, e.g. “03/MV2/5AC”. The first line is the version number, the 
second is the product identifier, and the third is an internal identification code. 
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3-2 MOUNTING PRECAUTIONS 

When mounting the MagVector MV2 on the printed circuit board (PCB), it is 
important to avoid stress. Stress induces piezoelectric voltages that interfere with 
the measurement of the Hall voltages; in particular, they vary with temperature 
and can cause offset drifts with very long time constants. 

Specific recommendations include: 

 PCBs made of FR-4 are recommended over, for example, ceramic PCBs, 
since the coefficient of thermal expansion of the substrate better matches 
that of the package. 

 After soldering, the package should not be mechanically constrained in any 
way. 

3-3 ABSOLUTE MAXIMUM RATINGS 

Table 1. Absolute maximum ratings 

Parameters Min Max Unit 

DC voltage at VCC -0.5 7 V 

DC voltage at VDD -0.5 4 V 

Input current on any pin (1) -100 100 mA 

Electrostatic discharge (2)  ±2 kV 

Package thermal resistance:    

– Junction to ambient (Theta JA) 50 °C/W 

– Junction to case (Theta JC) 12 °C/W 

Storage temperature -40 150 °C 

Notes: 

These values denote absolute maximum ratings. These ratings are stress ratings 
only. Functional operation of the device at these conditions is not implied. 
Exposure to absolute maximum rating conditions for extended periods may affect 
device reliability. 

(1) Norm: JEDEC78 

(2) Norm: MIL 883 E method 3015 
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3-4 OPERATING CONDITIONS 

Table 2. Operating conditions 

Parameter Symbol Min Typ Max Unit 

DC supply voltage VCC 4.5 5 5.5 V 

DC supply voltage VDD 3.28 3.3 3.32 V 

DC supply current Isup 17 18.5 20 mA 

Digital input signals:      

– “Low” input voltage Vil   30% of VCC V 

– “High” input voltage  Vih 70% of VCC   V 

– Input current Ii ±30  ±100 µA 

Digital output signals:      

– “Low” output voltage (1) Vol   0.4 V 

– “High” output voltage (2) Voh 4   V 

Operating temperature Top -40  +125 °C 

Notes:  

The maximum drive capability of the analog outputs is 100 kΩ / 500 pF. 

The digital input levels must match the supply used: 5 V when supplied with 5 V 
and 3.3 V when supplied with 3.3 V. 

The digital output level matches the supply used: 5 V when supplied with 5 V and 
3.3 V when supplied with 3.3 V. 

Measurement conditions: VCC = 5 V; Io = +1 mA. 

Measurement conditions: VCC = 5 V; Io = -1 mA. 
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3-5 PINOUT 

Top view: 

 

The functions of the pins differ according to the mode of operation, analog or 
digital – see Table 3 and Table 4. Unused pins can be left unconnected; the 
internal pull-down resistor is ~100 kΩ. 

Table 3. Pinout – analog mode operation 

Pin Name Type Direction Description Pad input 
option 

1 RA0 Digital In Field range 0 Pull-down 

2 RA1 Digital In Field range 1 Pull-down 

3 MA0 Digital In Meas. Axis 0 Pull-down 

4 MA1 Digital In Meas. Axis 1 Pull-down 

5 Z Analog Out Z-axis output  

6 TEMP Analog Out Temperature output  

7 REF Analog Out Volt. reference (VCC/2)  

8 VDD Supply Power Internal core supply voltage  
(3.3 V) 

 

9 D-A Digital In Digital - Analog mode 1 

10 LP Digital In Low power mode Pull-down 

11 INV Digital In Output inversion Pull-down 

12 EMR Digital In Extended Measurement 
Range 

Pull-down 

13 GND Supply Power Ground  

14 VCC Supply Power Main supply voltage (5 V)  

15 Y Analog Out Y-axis output  

16 X Analog Out X-axis output  
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Table 4. Pinout – digital mode operation 

Pin Name Type Direction Description Pad input 
option 

1 MISO Digital Out Serial MISO Pull-down 

2 SCLK Digital In Serial CLK Pull-down 

3 CS Digital In Serial CS Pull-down 

4 MOSI Digital In Serial MOSI Pull-down 

8 VDD Supply Power Internal core supply voltage  
(3.3 V) 

 

9 D-A Digital In Digital - Analog mode 0 or floating 

10 INIT Digital In ADC initialization Pull-down 

11 INV Digital In Analog mode output inversion 0 or floating 

12 DR Digital Out Data ready Pull-down 

13 GND Supply Power Ground  

14 VCC Supply Power Main supply voltage (5 V)  

Unused pins may be left unconnected. Note, however, that the INV control line, 
normally used only for Analog mode, also affects Digital mode operation; 
consequently, if connected in Digital mode, it should be tied to LOGIC 0. 

3-6 POWER SUPPLY 

The MagVector MV2 is designed to be supplied with 5 V. An on-chip voltage 
regulator reduces and stabilizes the 5 V down to 3.3 V, which is the chip core 
supply voltage. However, it is also possible to supply the chip with 3.3 V. In that 
case, since there is no regulation, the supply needs to be stable within 0.5 % to 
reach the specified resolution. 

The digital output level matches the supply used: 5 V when supplied with 5 V and 
3.3 V when supplied with 3.3 V. 

When using a 5 V supply, the internal core supply voltage can be monitored on 
the VDD pad. 

 

Figure 2. Connections for 5 V supply (left) and 3.3 V supply (right) 

Notes: 

In the 3.3 V configuration, VCC must be shorted to VDD. 

The 10 µF capacitor values are approximate recommendations. In the 3.3 V 
configuration, the choice of the value of the decoupling capacitor depends on the 
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specifications of the external voltage regulator. It is recommended to place a 
100 nF decoupling capacitor in parallel to each 10 µF capacitors. 

3-7 OPERATING MODES 

The MagVector MV2 can be operated in two modes: digital or analog, depending 
on the logic level of the D-A input pin. If the D-A pin is tied to LOGIC 0 or left 
floating, the MagVector MV2 is operating in digital mode (default). In order to 
switch the operating mode of the MagVector MV2 from digital to analog, the D-A 
pin has to be tied to LOGIC 1 (VCC). 

Table 5. Operating modes 

D-A Mode See: 

0 DIGITAL Page 13, Section 5-Digital Mode Operation 

1 ANALOG Page 8, Section 4-Analog Mode Operation 

3-8 SENSING DEVICE 

The three components of the magnetic field are detected by three orthogonal Hall 

devices: the component 𝐵𝑧 normal to the die plane is detected by a conventional 
“horizontal” Hall sensor, whereas the two in-plane components 𝐵𝑥 and 𝐵𝑦 are 
detected by “vertical” Hall sensors (see Figure 3). 

 

Figure 3. Conceptual diagrams of horizontal (left) and vertical (right) Hall sensors 

The directions of the axes (Bx, By, Bz), relative to the QFN package, are shown in 
the diagram in Section 1-Overview. The axes are oriented as indicated by the 
arrows in digital mode, in the opposite direction in analog mode  (see Section 3-
7). 

The input and output leads of the Hall devices are sequentially permuted. This 
“spinning current” technique has several significant benefits: it minimizes the 
offset and, more importantly, the offset drift; it minimizes the Planar Hall Effect; 
and it minimizes 1/f noise. 

The sensing volume has the shape of a thin square slab, 200x200 µm in the die 
plane and about 5 µm high. The Hall sensors are distributed such that the 
measured Hall voltage of all three axes closely approximates the flux density 
averaged throughout the slab. The sensing volume is located, with a precision of 
50 µm, in the center of the QFN package, both horizontally and vertically. 

3-9 SIGNAL CONDITIONING 

By default, the 3 measurement signals are sequentially multiplexed, amplified and 
de-multiplexed (see Figure 4 for analog mode and Figure 6 for Digital Mode). This 
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means that a single amplifier is used for all 3 axes. By controlling the gain, the 
user sets the magnetic field range. A separate, fixed-gain amplifier amplifies the 
temperature sensor output. 

By default, the following ranges can be selected: 100 mT, 300 mT, 1 T and 3 T. 
The amplifier saturates when the magnetic field strength exceeds the range value 
by approximately 20%; for instance, if the range is 100 mT, the output saturates at 
around 120 mT. 

Additional option bits allow the range to be extended by 30% or by a factor 10x – 
see Section 12 for analog mode and Sections 5-21 and 5-22 for digital mode, 

3-10 MEASUREMENT AXIS SELECTION 

By default, the 3 magnetic axes are multiplexed continuously at a rate well above 
the output frequency. 

It is possible to prevent the continuous multiplexing and amplify just the x-, y- or z-
axis. Single-axis mode is useful when the user wants to optimize the signal-to-
noise ratio of one particular axis. 

This mode is also recommended when a large magnetic field is applied in a 
direction other than the one being measured. In such conditions, without enabling 
the single-axis mode, the amplifier may saturate when amplifying the large Hall 
voltage. Since the amplifier recovery time is relatively long, the saturation can 
affect the value read for other axes. 

Note that in single-axis mode, only one of the 3 magnetic field channels provides 
meaningful values. For instance, if the selected measurement axis is only x, the 
channels y and z are disabled, and therefore provide non-usable outputs. 
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MagVector
™

 MV2 3-axis magnetic sensor 

4- Analog Mode Operation 

4-1 SPECIFICATIONS 

Table 6. Performance specifications in analog mode 

Performance specifications in analog mode, VDD = 5 V, T = 25°C 

Parameter Min Typ Max Unit Note 

Sensitivity 3 T range 0.42 0.50 0.58 V/T  

1 T range 1.26 1.50 1.74 

300 mT range 4.2 5.0 5.8 

100 mT range 12.6 15.0 17.4 

Sensitivity drift  All ranges  ±200 ±400 ppm/°C  

Measurement bandwidth 50   kHz  

Repeatability   0.1 %  

Spectral noise density X & Y axis  330  nT/√Hz  

Z axis  225  nT/√Hz  

RMS noise X & Y axis  8  µT RMS  (0 - 600 Hz) 

Z axis  5.5  µT RMS  (0 - 600 Hz) 

Static offset  30 50 mV With respect to VCC/2 

Offset temperature drift   0.1 mV/°C  

Temperature output sensitivity  4.2  mV/°C  

Temperature output @ 27°C 1.25  1.35 V  
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4-2 SIGNAL CONDITIONING – ANALOG MODE 

 

Figure 4. Block diagram of the signal conditioning – analog mode 

4-3 OUTPUT STAGE 

The analog voltages representing the magnetic field and the chip temperature are 
buffered through the output “Buf” stage. The maximum drive capability of the 
analog outputs is 100 kΩ / 500 pF. 

The magnetic field outputs (Vx, Vy and Vz) are referenced to VCC/2, 
corresponding to zero magnetic field. This reference voltage is generated 
internally and available on the REF pin. 

Vtemp is referenced to GND. 
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4-4 APPLICATION CIRCUIT  

 

Figure 5. Circuits for sensor control and reading – analog mode 

Note that all input pins are in pull-down configuration, i.e. if an input pin is not 
connected (left floating), it is considered as a LOGIC 0 setting. 

4-5 OPTION SETTINGS IN ANALOG MODE 

Note that the D-A pin has to be tied to LOGIC 1 (VCC). The following options can 
be selected in analog mode: 

Table 7. Selectable options – analog mode 

Pin  Name Description See 

1 RA0 Range LSB Page 11, Section 4-6 

2 RA1 Range MSB Page 11, Section 4-6 

3 MA0 Measurement Axis LSB Page 11, Section 4-7 

4 MA1 Measurement Axis MSB Page 11, Section 4-7 

10 LP Low Power Page 11, Section 4-8 

11 INV Invert Page 12, Section 4-9 

12 EMR Extended Measurement Range Page 12, Section 4-10 
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4-6 RA – RANGE  

Pins: RA0 (1), RA1 (2) 

The RA parameter sets the amplification gain. When the measured magnetic field 
is within the range (between - range to + range), the sensor output is proportional 
to the applied magnetic field amplitude.  

 

Table 8. Range selection – analog mode 

RA1 RA0 Magnetic field 
range 

 

0 0 ±100 mT 

0 1 ±300 mT 

1 0 ±1 T 

1 1 ±3 T 

   

4-7 MA – MEASUREMENT AXIS 

Pins: MA0 (3), MA1 (4) 

The parameter MA determines which Hall device is amplified. Depending on the 
setting, all 3 axes are sequentially scanned and amplified, or the scanning is 
stopped and only one selected axis is amplified. See the table below. 

The pins MA0 and MA1 are tied to GND (or left floating) or VCC to determine their 
logic state, LOGIC 0 or LOGIC 1, respectively. 

Table 9. Measurement axis selection – analog mode 

MA1 MA0 Measurement axis 

 

0 0 3 axis 

0 1 X axis 

1 0 Y axis 

1 1 Z axis 

   

4-8 LP – LOW POWER 

Pin: LP (10) 

The MagVector MV2 can be switched to a low power mode by setting the LP pin 
to LOGIC 1. This mode reduces the current consumption by ~6 mA and the SNR 
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by a factor of √2. Note that other parameters, such as temperature drift or offset, 
can also change. 

4-9 INV – INVERT 

Pin: INV (11) 

When the INV pin is tied to LOGIC 1, the MagVector MV2 reverses the Hall bias 
currents, and therefore reverses the measured magnetic field voltages relative to 
the REF pin (VCC/2). Toggling this option can be used, for example, to emulate a 
low frequency modulator / demodulator. 

4-10 EMR – EXTENDED MEASUREMENT RANGE 

Pin: EMR (12) 

When the EMR option is enabled by tying the EMR pin to LOGIC 1, the 
MagVector MV2 increases the selected range by 30%. The intended purpose of 
this option is to approximately compensate the reduced voltage swing of the 
output buffer when using a 3.3 V supply instead of 5 V. 
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MagVector
™

 MV2 3-axis magnetic sensor 

5- Digital Mode Operation 

5-1 SPECIFICATIONS 

Table 10. Performance specifications in digital mode. 

Performance specifications in digital mode, VDD = 5 V, T = 25°C 

Parameter Min Typ Max Unit Note 

Sensitivity1 

3 T range 7.3 7.5 7.8 

LSB/mT  

1 T range 22 22.5 23 

300 mT 
range 

72 73.4 74 

100 mT 
range 

213 214 217 

Sensitivity drift  All ranges - ±200 ±400 ppm/°C 
Can be compensated by 
programming 

Measurement rate 0.375  3 kHz Programmable 

Number of bits delivered 14  16  Programmable 

Spectral noise 
density 

X & Y axis  330  nT/√Hz  

Z axis  225  nT/√Hz  

RMS noise 
X & Y axis  8  µT RMS  (0 - 600 Hz) 

Z axis  5.5  µT RMS  (0 - 600 Hz) 

Static offset1  250 350 LSB  

Offset temperature drift  6  µT/°C  

Temperature output sensitivity1  46  LSB/°C  

Temperature output @ 27°C  23000  LSB  

                                            

 
1 For 16-bit resolution. For lower resolution (15 or 14 bits), the values must be rescaled by a factor 2 or 4, 
respectively. 
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Table 11. Serial Peripheral Interface specification 

Maximum clock frequency 10 MHz 

Clock duty cycle 50% 

SPI standard: 
- CPOL (Clock Polarity) 
- CPHA (Clock Phase) 

Mode 0: 
0: CLK idle state = Low 
0: CLK readout edge = Rising 

CS idle state High 

CS setup time 50 ns 

CS hold time 50 ns 

DORD (Data order) 0: MSB first 

Data word size 16 bits 

Minimum data word separation 100 ns 

Data availability DR or MISO – see Section 5-16 

5-2 SIGNAL CONDITIONING – DIGITAL MODE 

 

Figure 6. Block diagram of the signal conditioning – digital mode 

5-3 A/D CONVERSION 

The magnetic field signals out of the amplifier are de-multiplexed to the 3 A/D 
converters (see Figure 6). 

Each A/D conversion requires several samples to generate one output. The A/D 
output rate can be adjusted by the user, from 0.375 to 3 kHz. The output rate 
determines the integration time and, as a consequence, the measurement 
resolution. This is why the parameter affecting the A/D rate is called “resolution” 
(RE). The tradeoff for the user is a low bandwidth, low noise output, or a high 
bandwidth, noisier output. 
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The number of bits delivered by the MagVector MV2 always exceeds the 
resolution. In other words, the least significant bit is always fluctuating. This allows 
the user to further average the signal. When the resolution parameter is changed, 
the number of bits delivered to the output automatically changes (it can go from 
14 to 16 bits). 

When selecting the RE parameter, the user affects all four A/D conversions 
equally. 

The A/D conversion block can be controlled by a logic input on INIT pin. Enabling 
INIT (tied to LOGIC 1) will reset and halt the A/D conversion; disabling INIT 
(floating or tied to LOGIC 0) will reinitialize and start the A/D conversion block 
operating. This option can be helpful to control the precise A/D conversion time. In 
normal operation, it is recommended to leave the INIT pin not connected. 

The end of the A/D conversion on the selected output channel is indicated by a 
Data Ready signal (see Section 5-5), which by default is routed to the DR pin. 
Optionally, this signal can be multiplexed with the MISO signal (see Section 5-16). 

5-4 OUTPUT STAGE 

The digital value out of each A/D is stored in the output stage. When the user 
requests a certain output (one of the 3 axes or the temperature), the output stage 
multiplexer picks the selected channel and the value is transferred to the SPI 
interface. 

Note that in the single axis mode, of the 3 magnetic field channels, only one 
contains meaningful data. For instance, if the measurement axis selected is only 
x, the channels y and z are disabled, and therefore provide zero-field digital 
values. 

5-5 APPLICATION CIRCUIT 

The MagVector MV2 is logical slave, and therefore the controller must send a chip 
select (CS) and clock signal (CLK) in order to receive the data from the sensor 
(MISO). The data consists of the digital value of the selected output. Prior to 
receiving the data, the user must send a request containing some user settings. 
The request usually contains the output channel.  

 

Figure 7. Circuit for sensor control and reading – digital mode 

The Data Ready (DR) signal indicates that new data is ready (LOGIC 1); 
otherwise old data will be reread (LOGIC 0). DR passes from LOGIC 1 to 
LOGIC 0 as soon as the SPI transfer starts (CS goes from LOGIC 1 to LOGIC 0). 
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By selecting the appropriate option bit, the Data Ready signal can be multiplexed 
with MISO, instead of requiring a signal line of its own (see Section 5-16). The 
controller can also control the exact timing of the A/D conversion, using the INIT 
pin (see Section 5-3). 

5-6 MULTIPLE DEVICES 

It is possible to connect several MagVector MV2s on the same SPI bus. In this 
case, SCLK, MISO and MOSI are connected in parallel, while the CS signal is 
individual per chip. To avoid conflicting flows of data, only one data out (MISO pin) 
should be enabled at the time. For this reason the default value of the MISO pin is 
DISABLED and remains in a high impedance state (“tristate” logic) when the chip 
is in an idle state (CS high). 

 

Figure 8. Parallel connection of MagVector MV2s 

5-7 SERIAL COMMUNICATION 

The MagVector MV2 is read and programmed by a master controller through a 
standard 4-wire Serial Peripheral Interface (SPI). See Table 11 for a summary of 
the SPI specification. 

The sensor data are sent to the master via the MISO (Master In Slave Out) pin 
and the sensor can be programmed through MOSI (Master Out Slave In) pin. The 
MISO and MOSI words are 16 bits long. Within one single series of 16 clock 
counts, sent by the master, one MISO word and one MOSI word can be 
transmitted simultaneously. Two successive words must be separated by at least 
100 ns. 

 

Figure 9. Timing diagram of one word 
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The availability of new data at the SPI port is indicated by DR signal. When a SPI 
communication cycle starts (falling edge of CS), the DR signal is cleared until new 
data is available in the SPI output buffer. The SPI output buffer refresh rate 
depends on the A/D output rate (see Section 5-3). 

5-8 COMMUNICATION PROTOCOL 

The sensor is configured by sending a 16-bit word through the MOSI pin (see 
Section 5-9). In particular, this includes the requested measurement axis. The 
configuration data are then stored in one of three volatile registers, and will remain 
until another data word is sent to the same register or until the chip is powered off. 

The sensor returns the Hall measurement of the requested axis as a 16-bit 
unsigned integer value (see Section 5-10). As a data word is read from the 
MagVector MV2, the configuration data for the next data word to be read 
(indicating, for instance, another measurement axis) can be sent simultaneously, 
within the same series of 16 clock counts (see fig. 4).  

 

Figure 10. Sequence of data for communicating with the MagVector MV2 

The user can read back the contents of the configuration registers at any time. By 
sending a request in the form of 8 bits (see Section 5-9), the MagVector MV2 
returns the register value within the same transmission. 

 

Figure 11. Timing diagram of the register read back 
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5-9 DATA FORMAT – DATA IN 

To configure the device, a 16-bit word has to be sent. This word is composed of 
an 8-bit control address and an 8-bit value containing the user settings, as shown 
in Figure 12 and described in greater detail in Table 12. 

 

Figure 12. Format of Data In 

Table 12. Format of Data In 

Bit Description 

15 (MSB), 14 Don’t Care 

13 1 = Write: write the register 

12 1 = Read: read back the register 

11, 10 11 

9, 8 

Register number (see Section 5-11): 

00: primary measurement specifications 

01: other measurement options 

10: temperature compensation and test 

7 – 0 (LSB) Register value to be programmed 

 

Example: Configure the MagVector MV2 to read the Y-axis with a resolution of 15 
bits, while the 3 measurement axes are scanned, with measurement range of 
300 mT. The request to be sent is: 

0 0 0 1 1 1 0 0 - 0 0 0 1 0 1 0 1 

5-10 DATA FORMAT – DATA OUT 

The magnetic field amplitude is transmitted in a word of 16 bits. The MSB is 
transmitted first. 

 

Figure 13. Format of Data Out 

The digital output is an unsigned integer value, comprised between 0 and 2N, 
where N is the selected resolution of the A/D converter (N=13, 14, 15 or 16; see 
Section 5-12). 
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At zero magnetic field, the output would ideally be half the maximum value, 2N/2 
(see Figure 14 for the case N =16 and 100 mT field range). In reality, the value 
will correspond to the sensor offset. When the MagVector MV2 is exposed to a 
magnetic field, the output value is proportional to the field up to the field range 
(100 mT, 300 mT, 1 T or 3 T), with a proportionality constant being the sensitivity 
parameter in Table 10. The ADC saturates at a field about 20% larger than the 
range. 

 

Figure 14. Output of one particular axis as a function of the field amplitude when the resolution is 16 bits, 
unsigned value representation. 

5-11 REGISTERS 

The following tables summarize the function of each bit in the three registers. 
Subsequent sections provide additional detail. 

Table 13. Contents of Register 00 

Register 00 Default value: all zeroes 

Bit  Name Description See 

7 (MSB) MA1 Measurement Axis MSB Page 22, Section 5-15 

6 MA0 Measurement Axis LSB Page 22, Section 5-15 

5 RE1 Resolution MSB Page 21, Section 5-14 

4 RE0 Resolution LSB Page 21, Section 5-14 

3 RA1 Range MSB Page 21, Section 5-13 

2 RA0 Range LSB Page 21, Section 5-13 

1 OS1 Output Selection MSB Page 20, Section 5-12 

0 (LSB) OS0 Output Selection LSB Page 20, Section 5-12 
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Table 14. Contents of Register 01 

Register 01 Default value: all zeroes 

Bit  Name Description See 

7 (MSB) LMR Large Measurement Range Page 24, Section 5-22 

6 SC Spinning Current Must be zero 

5 EMR Extended Measurement Range Page 24, Section 5-21 

4 HC High Clock Page 24, Section 5-20 

3 INV Invert Page 24, Section 5-19 

2 LP Low Power Page 23, Section 5-18 

1 PO Permanent Output Page 23, Section 5-17 

0 (LSB) SP Status Position Page 23, Section 5-16 

Table 15. Contents of Register 10 

Register 10 Default values: DSB = TSC = 0, TC = 0001 

Bit  Name Description See 

7 (MSB) DSB Disable Separated Bias Must be zero 

6 TC3 Temperature Compensation 3 
(MSB) 

Page 24, Section 5-23 

5 TC2 Temperature Compensation 2 Page 24, Section 5-23 

4 TC1 Temperature Compensation 1 Page 24, Section 5-23 

3 TC0 Temperature Compensation 0 
(LSB) 

Page 24, Section 5-23 

2 TSC Test System Clock Must be zero 

1  Unused  

0 (LSB)  Unused  

5-12 OS – OUTPUT SELECTION 

Register: 00 

Bits: <Bit0> and <Bit1> 

This option selects the channel (Bx, By, Bz or T) that will be delivered in the next 
SPI word out. 

Note: when changing the range, or when changing the axis in single axis mode, 
the user should wait until the value is stable. The required delay corresponds to 
the ADC refresh rate: from 0.375 kHz to 3 kHz, depending on the resolution 
chosen.  
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Table 16. Output Selection 

OS1 OS0 Data Out 

 

0 0 Bx 

0 1 By 

1 0 Bz 

1 1 T 

   

5-13 RA – RANGE 

Register: 00 

Bits: <Bit2> and <Bit3> 

The RA parameter sets the amplification gain. When the measured magnetic field 
is within the range (between - range to + range), the sensor output is proportional 
to the applied magnetic field amplitude. 

Note that the range also depends on the Extended Measurement Range (EMR –
 see Section 5-21) and Large Measurement Range (LMR – see Section 5-22) bits; 
the effective range is RA * (1 + 0.333 * EMR + 9 * LMR). 

 

Table 17. RA – Range selection – digital mode 

RA1 RA0 Magnetic field 
range  

 

0 0 ±100 mT 

0 1 ±300 mT 

1 0 ±1 T 

1 1 ±3 T 

   

5-14 RE – RESOLUTION 

Register: 00 

Bits: <Bit4> and <Bit5> 

The resolution of the Analog-to-Digital (A/D) conversion is set by the parameter 
RE. This parameter affects the conversion time and the refresh rate at the output. 
Since a greater integration time reduces the noise, the parameter RE also 
changes the number of delivered bits. 
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Table 18. RE – Resolution Selection 

RE1 RE0 Number 
of bits 

Refresh 
rate 
(kHz) 

 

0 0 14 3 

0 1 15 1.5 

1 0 16 0.75 

1 1 16 0.375 

    

When the number of bits delivered N is smaller than 16, then the last 16-N bits 
(LSB) are zeros. For instance, if the number of bits delivered is 14, the output 
format is as follows: 

 

Figure 15. Timing of the data out when the resolution set to 14 bits. 

5-15 MA – MEASUREMENT AXIS 

Register: 00 

Bits: <Bit6> and <Bit7> 

The parameter MA determines which Hall device is amplified. Depending on the 
setting, all 3 axes are sequentially scanned (at the rate specified by the RE 
parameter – see Section 5-14) and amplified, or the scanning is stopped and only 
one selected axis is amplified. See the table below. 

Table 19. MA – Measurement axis selection – digital mode 

MA1 MA0 Measurement axis 

 

0 0 3 axes 

0 1 X axis 

1 0 Y axis 

1 1 Z axis 
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5-16 SP – STATUS POSITION 

Register: 01 

Bits: <Bit0>  

The availability of a new data to be read via SPI is indicated by the status signal 
Data Ready (see Section 5-5). By default, this signal is routed to the DR pin. To 
minimize the number of connections between the MagVector MV2 and a 
controller, the DR signal can be multiplexed with the MISO pin when SPI is idle 
(CS pin at LOGIC 1). 

Note that the PO (Permanent Output MISO) option has to be enabled to use this 
option. 

The hardware position of Data Ready signal is summarized below. 

Table 20. Status Position bit 

SP CS Pin 1 Pin 12 

0 0 MISO DR 

0 1 MISO DR 

1 0 MISO hiZ 

1 1 DR hiZ 

5-17 PO – PERMANENT OUTPUT 

Register: 01 

Bits: <Bit1>  

By default, the SPI output is disabled and the MISO pin is in a high impedance 
state (tri-stated) when the SPI is in idle state (CS pin is tied to LOGIC 1). This 
allows connecting several MagVector MV2s in parallel on the same SPI bus.  

However, a MISO pin in high impedance state may generate a significant current 
consumption out of the master device. Therefore, if there is only a single 
MagVector MV2 on the SPI bus, it is recommended to permanently activate the 
MISO output. In this case, the MISO output remains at a well-defined logic level, 
even when SPI is idle (CS pin at LOGIC 1). 

5-18 LP – LOW POWER 

Register: 01 

Bits: <Bit2>  

The MagVector MV2 can be switched to a low power mode. This mode reduces 
the current consumption by ~6 mA and the SNR by a factor of √2. Note that other 
parameters, such as temperature drift or offset, can also change. 
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5-19 INV – INVERT 

Register: 01 

Bits: <Bit3>  

When the INV option is enabled, the MagVector MV2 reverses the Hall bias 
currents, and therefore reverses the measured magnetic field outputs relative to 
2N/2 (where N represents the ADC resolution). Toggling this option can be used, 
for example, to emulate a low frequency modulator / demodulator. 

5-20 HC – HIGH CLOCK 

Register: 01 

Bits: <Bit4>  

Enabling the HC option doubles the analog clock, which improves the SNR, 
typically by a factor of √2. However, in three-axis measurement mode (MA = 00), 
the MagVector MV2 may suffer from a slight cross-sensitivity between axes, and 
selecting this option will provide worse cross sensitivity. 

5-21 EMR – EXTENDED MEASUREMENT RANGE 

Register: 01 

Bits: <Bit5>  

Enabling the EMR option increases the selected range (RA – see Section 5-13) 
by 30%. In principle, this option is intended to be used in analog mode (see 
Section 4-10), to approximately compensate the reduced voltage swing of the 
output buffer when using a 3.3 V supply instead of 5 V.  

5-22 LMR – LARGE MEASUREMENT RANGE 

Register: 01 

Bits: <Bit7>  

Enabling the LMR option increases the selected range (RA – see Section 5-13) by 
10x. This option is intended to extend the measurement range to 10 or 30 T, for 
very strong fields. 

5-23 TC – TEMPERATURE COMPENSATION 

Register: 10 

Bits: <Bit3> through <Bit6> 

Typically, the sensitivity of the Hall devices drifts with temperature (see Table 10). 
In order to compensate the temperature induced sensitivity drift, the Hall bias can 
be programmed to acquire a linear dependence with temperature. By default, 

TC=0001, which means that the gain is constant. The optimum value of TC needs 
to be found experimentally. 
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MagVector
™

 MV2 3-axis magnetic sensor 

6- Evaluation Kit 

The MagVector™ MV2 Evaluation Kit provides a flexible turnkey hardware and 
software environment that allows all features of the MagVector MV2 to be 
exercised. The kit consists of: 

 Test board with MagVector MV2 sensor 

 Preprogrammed Arduino board that connects to the test board 

 Arduino firmware to drive the MagVector MV2, including source code 

 Host software to exercise the MagVector MV2, including source code 

 Two unmounted MagVector MV2 sensors 

6-1 TEST BOARD 

The test board is as shown in Figure 16. The schematics are shown in Figure 17, 
and the signal routing is summarized in Table 21. 

 

Figure 16. MagVector MV2 Evaluation Kit test board. 

The MagVector MV2 is located on the end of the protrusion shown on the right, at 
location U1. The exact location of its field sensitive volume is indicated on the 
PCB. The MV2’s thermal flag is soldered to a thermal pad, which in turn is 
connected by thermal vias to the ground plane on the back side of the protrusion.2 
If needed, the protrusion can be cut off, and reconnected to the rest of the test 
board with a ribbon cable (ribbon-cable connectors at P6 and P7). 

The test board can power the MV2 at 3.3V or 5V, selectable by two jumpers at 
W1 and W2. The jumper settings are as indicated on the PCB. If 5V is selected, 
the MagVector MV2 is powered directly by the 5V supply provided by the Arduino, 

                                            

 
2 See, for example, the Cirrus Logic Application Note AN315, “Thermal Considerations for QFN Packaged Integrated 
Circuits.”  

https://www.cirrus.com/cn/pubs/appNote/AN315REV1.pdf
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and uses the internal regulator. If 3.3V is selected, the MagVector MV2 is 
powered by a precision regulator, powered in turn by the Arduino’s 5V supply. 

 

Figure 17. Schematics of MagVector MV2 Evaluation Kit test board 
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Table 21. Signal routing of MagVector MV2 Evaluation Kit test board 

MagVector MV2 Arduino UNO Description 
Pin Analog Digital Header pin Signal Direction  

1 RA0 MISO IOH-5 MISO Out / In Range / SPI MISO 

2 RA1 SCLK IOH-6 SCK Out Range / SPI clock 

3 MA0 CS IOH-3 SS Out Axis select / Chip Select 

4 MA1 MOSI IOH-4 MOSI Out Axis select / SPI MOSI 

5 Z - AD-3 AD2 In Bz analog output 

6 TEMP - AD-4 AD3 In Temperature analog 
output 

7 REF - AD-5 AD4 In VCC/2 analog output 

8 VDD (3.3V) AD-6 AD5 In Core supply monitor 

9 D-A (0V or VCC) IOH-1 IO8 Out Digital-analog selection 

10 LP INIT IOL-8 IO7 Out Low power / Start ADC 

11 INV - IOL-5 IO4 Out Invert 

12 EMR DR IOL-3 IO2 Out Large range / Data Ready 

13 GND POWER-6 GND - Ground 

14 VCC (5V or 3.3V) IOH-8 AREF In VCC for ADC reference 

15 Y - AD-2 AD1 In By analog output 

16 X - AD-1 AD0 In Bx analog output 

- - - POWER-5 +5V - 5V supply from Arduino 

Note that all the analog-output signals – X, Y, Z, TEMP, plus REF and VCC – are 
routed to the Arduino UNO’s analog inputs, where they can be digitized. However, 
the Arduino UNO has 10-bit ADCs; to digitize the signal with higher resolution, an 
external digitizer can be connected to connector P5. The pin-out of this connector 
is shown in Table 22. 

Table 22. Connections from MagVector MV2 Evaluation Kit test board to external digitizer. 

Pin Signal 

P5-1 X 

P5-2 Y 

P5-3 Z 

P5-4 TEMP 

P5-5 REF 

P5-6 n/c 

P5-7 VDD 

P5-8 VCC 

P5-9 GND 

P5-10 GND 

6-2 ARDUINO BOARD 

Arduino is a widely-used, open-source prototyping platform based on easy-to-use 
hardware and software. The Arduino Integrated Development Environment (IDE) 
and extensive documentation is available from the site https://www.arduino.cc.  

An Arduino UNO, touted as the most robust board in the Arduino family, is 
included in the MagVector MV2 Evaluation Kit. Note that due to a trademark 
conflict, the Arduino UNO is sold as the “Genuino UNO” outside of the USA. 

https://www.arduino.cc/
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As shown in Figure 18, the Arduino UNO’s connectors mate exactly with those on 
the test board: the Arduino UNO Digital headers (IOL and IOH) connect to P1 and 
P2, respectively, on the test board; the Arduino UNO Analog (AD) and Power 
(POWER) headers connect to P3 and P4, respectively, on the test board. Note 
that the last two pins of the Digital header (IOH-9 – SDA and IOH-10 – SCL are 
not connected to the test board.  

 

Figure 18. Arduino/Genuino UNO connected to MagVector MV2 test board. 

The Arduino UNO is usually powered by USB, but it can optionally be powered by 
an external supply of 7 to 12V – see the technical documentation for the Arduino 
UNO. 

The Arduino UNO connects to the host computer via a standard USB cable. It 
uses the USB CDC (USB Communications Device Class) protocol, which 
automatically creates a virtual serial port on modern Windows, Macintosh or Linux 
platforms. The serial port is named as follows: 

 Windows: COMx, where “x” depends on the number of other COM ports 
installed. For the Arduino to be properly recognized, you have to install the 
“arduino.inf” file included in the directory “MV2\binaries\windows\drivers” of 
the MagVector MV2 Evaluation Kit: in the Windows Explorer, right-click on 
the file name and select “Install”. 

 Macintosh: /dev/cu.usbmodemX, where “X” depends on the USB port the 
Arduino is plugged into.3 Use the command “ls /dev/cu.usbmodem*” to 
determine the exact name of the virtual serial device. USB CDC support is 
included in Mac OS X 10.3.7 and later. 

 Linux: /dev/ttyACMx, where “x” depends on the number of other ACM 
(“Abstract Control Model”) modems installed.3 You may have to modify the 
access rights; see, for example, this post for Ubuntu. Note that the 

                                            

 
3 In fact, two devices are created: /dev/tty… and /dev/cu…. In Unix systems, /dev/tty was historically used for 
incoming calls on a modem; an open will stall until the modem asserts DCD (Data Carrier Detect). In contrast, 
/dev/cu was used for outgoing calls (“cu” stands for “calling unit”), and an open completes immediately. In this 
context, you should use /dev/cu. 

http://arduino-er.blogspot.ch/2014/08/arduino-ide-error-avrdude-seropen-cant.html
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standard rxtx library does not support these device names; you can use a 
patched version of the library (see, for example, this patch for Ubuntu), or 
you can create a symbolic link from /dev/ttyACMx to /dev/ttyUSBx. The 
Arduino IDE (see Section 6-3) uses a patched version of the rxtx library. 

Note that the Arduino enumerates itself as an ACM modem, but in fact it does not 
respond to the Hayes control protocol at all. 

6-3 ARDUINO FIRMWARE 

6-3-1 Functional overview 

The Arduino firmware is a general-purpose driver, capable of exercising every 
feature of the MV2, in either analog or digital mode. 

It reads a command script from the host serial port, executes it, and returns the 
results via the host serial port. The command script may include a single level of 
looping. The command script input and the resulting output have a header 
specifying the transfer length and a trailer with a CRC. The output also includes a 
return status. 

The script buffer sent to the firmware is structured as follows: (lengths given as 
16-bit words) 

Header (1 W) Script (64 W max) CRC (1 W) 

The response buffer received from the firmware is structured as follows: 

Header (1 W) Results (496 W max) Status (2 W) CRC (1 W) 

 In both cases, Header is the length in bytes of the entire buffer to be 
transferred (including header and CRC), and CRC is the 16-bit exclusive-OR 
of the entire buffer up to the CRC. 

 Script is a variable-length list of 1-word commands, as defined in Subsection 
6-3-2. 

 Results is a variable-length list of 1-word values containing the return value 
for each command that returns one. 

 Status is a 1-word Error Code followed by a 1-word Error Description, as 
defined in Subsection 6-3-3. 

6-3-2 Command definitions 

The general command structure is as follows: 

Command Type Command Value 

15 
MSB 

14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 
LSB 

 Bits 15 and 14 define a class of commands: 

o 00: Digital commands 

o 01: Analog commands 

o 11: Miscellaneous commands 

 Bits 13 to 8 define a specific command. 

 Bits 7 to 0 define the value to write. 

https://launchpad.net/ubuntu/+source/rxtx/2.2pre2-3
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The commands are summarized in Table 23: 

Table 23. Command definitions. 

DIGITAL MODE COMMANDS 

Command Type 
(Hex) 

Command Value Description Return value 

1C 00 Read Register 00 Register 0 contents 

1D 00 Read Register 01 Register 1 contents 

1E 00 Read Register 10 Register 2 contents 

2C XX = Register value Write Register 00 Previously selected data value 

2D XX = Register value Write Register 01 Previously selected data value 

2E XX = Register value Write Register 10 Previously selected data value 

01 00 or 01 Set / Reset INIT bit None 

02 00 Wait for DR  None 

ANALOG MODE COMMANDS 

Command Type 
(Hex) 

 Command Value Description Return value 

41 00 Digitize Bx Bx 

42 00 Digitize By By 

43 00 Digitize Bz Bz 

44 00 Digitize 
Temperature 

Temperature 

45 XX: Bits Meaning 
 7 – 
 6 EMR 
 5 INV 
 4 LP 
 3,2 MA 
 1,0 RA 

Set control lines None 

MISCELLANEOUS COMMANDS 

Command Type 
(Hex) 

Command Value Description Return value 

C1 00 or 01 Set digital/analog 
mode 

None 

C2 XX = loop count Set loop start None 

C3 00 Set loop end None 

C4 00 Get firmware 
version 

Firmware version, in Binary 
Coded Decimal (e.g. 0x0102 

means version 1.2) 
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6-3-3 Return status definitions 

Table 24. Return status definitions 

Meaning Error Code Field Error Description Field 

No Error 0 None 

Syntax Error 101 Command number 

Mode Error 102 Command number 

Out of Memory Error 103 Command number 

Nested Loop Error 104 Command number 

Unspecified Loop Error 105 Command number 

Bad CRC Error 201 None 

Script Length Too Large Error 202 Script length 

No Valid Data From Host Error 203 None 

Transmission Error 204 None 

ADC Time Out Error 301 Command number 

6-3-4 Rebuilding the firmware 

The Arduino UNO included with the MagVector MV2 Evaluation Kit is 
preprogrammed with the latest firmware. Unless you want to update or customize 
the firmware/software, you can ignore this subsection. 

To recompile the firmware and reprogram the Arduino UNO, download and install 
the Arduino Integrated Development Environment (IDE), available for Windows, 
Macintosh and Linux. Once installed: 

 Copy the firmware source code from the MagVector MV2 Evaluation Kit, in 
the directory “MV2/Source/instrument/MV2”, to a directory on your 
computer. 

 Launch the Arduino IDE. 

 Within the IDE, open the file MV2.ino. 

 Select Tools > Board > Arduino/Genuino UNO. 

 Select Tools > Port > (virtual serial port name, as described in Section 6-2). 

 Select Sketch > Verify/Compile. 

 Select Sketch > Upload. 

Note that the Arduino IDE uses a default tab setting of 2 spaces, whereas the 
Metrolab code uses 4 spaces. To correct this, quit the Arduino IDE, open the 
Arduino preferences file, “preferences.txt”, change the “editor.tabs.size=” line, and 
restart the Arduino IDE. The preferences file is in AppData\Roaming\Arduino15 in 
Windows, ~/Library/Arduino15/ on Macintosh, and ~/.arduino15 in Linux. 

6-4 HOST SOFTWARE 

The host software uses the serial interface to the Arduino firmware to, for 
example, repeatedly measure Bx, By, Bz and Temperature. 

https://www.arduino.cc/en/Main/Software
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6-4-1 Functional overview 

The command scripts to be sent to the Arduino firmware (see Section 6-3-1) are 
read from a setup file, thereby allowing experimentation with all the MagVector 
MV2’s options. The setup file is a human-readable XML (Extensible Markup 
Language) file. 

The setup file contains two command scripts: one for initialization, and one for 
measurements. The measurement script also specifies: 

 The expected location of the measurement results in the output array, 
along with a label. 

 The number of times to run the measurement loop. If the count is zero, the 
measurement loop will run forever, until the user kills the program. 

 Any loop commands, with its count and an option to average the results. 

Included in the MagVector MV2 Evalution Kit are two basic setup files, one for 
analog mode and one for digital mode. 

The host software is written in C++, as a simple command-line program that can 
be compiled and run on Windows, Macintosh and Linux platforms. The results are 
written to the standard output, and errors to the standard error streams; this 
allows the results to be piped to another program or redirected to a recording file. 
The results can also be recorded to a file in the “Metrolab XML Record” (MXR) 
format. 

6-4-2 Installation and execution 

Copy the MV2 directory from the distribution medium to your computer. In a 
command shell, change your working directory to “MV2/binaries/<OS>”, where 
“<OS>” is your operating system type. 

Then execute MV2Host, with the following syntax: 

MV2Host <MV2ScriptXml-file> <MV2ScriptSchemaXsd-file> <COM port> 

[MXR-file] 

where: 

 <MV2ScriptXml-file> is the setup file that contains the commands sent to 
the MagVector MV2. The directory MV2/host/script contains two sample 
scripts, for analog and digital acquisition, respectively. 

 <MV2ScriptSchemaXsd-file> is the XML schema file, used to check the 
syntax of the setup file. You should normally use the file 
MV2/host/script/MV2/host/script.xsd. 

 <COM port> is the virtual serial port where the Arduino is plugged in, as 
described in Section 6-2. 

 [MXR-file] is an optional parameter that specifies the pathname of a 
“Metrolab XML Record” (MXR) file to which to record the measurements. 
This is a self-documenting, human-readable XML file. It consists of a 
header section and a body section; the body section, in turn, is 
decomposed into a series of datasets, each with a table of measurement 
data, column headings, and associated instrument settings. 
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Note that you may have to make the program executable (“chmod ugo+x 
MV2Host”). Also note that, for compatibility, MV2Host is built as a 32-bit 
executable. 

6-4-3 Setup file format 

Please see the sample files in the MV2/host/script directory. 

The overall structure of a setup file is as follows: 

<?xml version="1.0" encoding="UTF-8"?> 

<scripts> 

 <initialization> 

   … 

 </initialization> 

 <measurement repeat="…"> 

   … 

 </measurement> 

</scripts> 

where the <initialization> section defines the commands to be sent during 
initialization, and the <measurement> section during the measurement phase 
(see Section 6-4-1). The “repeat” parameter specifies the number of times the 
measurement script is to be executed; zero means an infinite number of times – 
i.e. until the user kills the program. 

A command to be sent to the MagVector MV2 (see Table 23) is specified as 
follows: 

  <command outputIndex="…" outputName="…"> 

   <type>…</type> 

   <value>…</value> 

  </command> 

where the “<type>” section specifies the Command Type, and the “<value>” 
section the Command Value, as hexadecimal bytes, as shown in Table 23. The 
“outputIndex” parameter specifies the index in the output buffer (array of 16-bit 
words) where the return value will be located, and the “outputName” parameter 
specifies a name for this data. Since the output buffer is ignored during 
initialization, these two parameters can be dropped for commands in the 
<initialization> section. 

A sequence of commands can be repeated using a <loop> section: 

  <loop count="…" average="true|false"> 

   … 
  </loop> 

where the “count” parameter specifies the loop count, and the “average” 
parameter specifies whether or not to average the results before returning them. 
Loops cannot be nested. 

6-4-4 Recompilation 

The MagVector MV2 Evaluation Kit host software is designed to be compiled in a 
Unix-style development environment (see Section 6-4-5). You must also have 
installed the libxml2 library and its headers (see Section 6-4-6). 

Once these requirements have been met, the build process should be 
straightforward: 
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 Copy the MagVector MV2 Evaluation Kit software – the directory “MV2” – 
to your computer. 

 In a command-line shell, change your working directory to MV2/host/build. 

 Type “make”. 

The Makefile has several options; the full syntax is as follows: 

  make [OPT=[DEBUG],[RELEASE]] [LIBXML_DIR=<path>] [all | clean] 

where 

 OPT=DEBUG compiles a debug version, with symbols and no optimization. 
Default is no symbols and -O3 optimization. 

 OPT=RELEASE builds a 32-bit, statically-linked executable. Default is 
native architecture, dynamically linked. 

 LIBXML_DIR=<path> specifies the location of libxml2 (see Section 6-4-6). 
Default is “../libxml”. 

 The “all” target builds the application. This is the default target. 

 The “clean” target deletes the build files. 

6-4-5 Development environment 

The build instructions are designed for a Unix-style development environment, 
using the Makefile mechanism. The recommended development environments for 
the different platforms are as follows: 

Windows: 

MinGW (Minimalist GNU for Windows) is a free and open source Unix-like 
development environment for creating native Windows applications. MSYS is an 
addition to MinGW, to provide a standard command shell. Install MinGW and 
MSYS as follows: 

 Download the MinGW setup program from http://www.mingw.org/. Execute 
it, and click the Install button to launch the MinGW Installation Manager.4 

 In the “MinGW Installation Manager,” select “Basic Setup” in the left-hand 
column, and mark the following packages for installation: 

o mingw32-base 

o mingw-developer-toolkit 

o mingw32-gcc-g++ 

o msys-base 

 Now select “All Packages” in the left-hand column, and mark the following 
additional packages for installation: 

o mingw32-liblzma 

o mingw32-pthreads-w32 

                                            

 
4 See http://www.mingw.org/wiki/getting_started for more details. 

http://www.mingw.org/
http://www.mingw.org/wiki/getting_started
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 Install all packages by clicking on the menu Installation > Apply Changes. 

 In the “msys\1.0\etc” subdirectory of your MinGW installation directory, 
there may be a file named "fstab". If so, open it with a text editor; if not, 
create one. Add the line: 

o C:\MinGW   /mingw 

substituting the full absolute path of your MinGW installation directory if 
different from C:\MinGW. Ensure that there is at least one blank line at the 
end of the file, then save and close the file. Ensure that the file name is 
“fstab,” without extension (text editors usually add “.txt” by default). 

 Change your PATH environment variable: 

o Add the path to your MinGW bin directory, by default “c:\MinGW\bin” 

o Add the path to your MSYS bin directory, by default 
“c:\MinGW\msys\1.0\bin” 

The MSYS launch script is located at “c:\MinGW\msys\1.0\msys.bat”. You have to 
manually create a shortcut if you want. Your MSYS home directory is 
“c:\MinGW\msys\1.0\home\<your user-name>”. 

Macintosh: 

 Install Apple’s Xcode development environment from the Mac App Store. 

 In a command shell, execute “xcode-select --install” to install the command 
line tools. 

 For older versions of MacOS, see the Xcode installation instructions on the 
MacPorts web site. 

Linux: 

 Install the GNU C++ compiler. For example, in Ubuntu, execute “sudo apt-
get install g++”, or install the “g++” package in the Ubuntu Software Center. 
To be able to compile a 32-bit application on a 64-bit system, be sure you 

have “multilib” support for gcc (e.g. “gcc-4.8-multilib” package under 
Ubuntu 14.04) as well as g++ (e.g. “g++-4.8-multilib”). 

6-4-6 Installing the libxml2 library 

Building the MagVector MV2 Evaluation Kit host software requires version 2.9.x or 
later of libxml2, a widely used XML (Extensible Markup Language) parser. The 
developer package, which includes the header files and both static- and dynamic-
link libraries, are required. There are many ways to install libxml2 (see 
xmlsoft.org); here are a few possibilities: 

Windows: 

Download libxml2 and supporting libraries (iconv, zlib) from the web site of Igor 
Zlatkovic, the maintainer of the Windows port. The three libraries are available via 
FTP from his download area, as 7-Zip (“.7z”) archive files. Use, for example, the 
Easy 7-Zip utility to extract the subdirectories (bin, include, lib, share) to 
MV2/host/libxml, the default location expected by the Makefile. Include the 
MV2/host/libxml/bin subdirectory in the execution path, so the MV2Host.exe 
executable can find its DLLs. Note: because of incompatibilities between MinGW 

https://guide.macports.org/#installing.xcode
https://guide.macports.org/#installing.xcode
http://xmlsoft.org/index.html
https://www.zlatkovic.com/libxml.en.html
https://www.zlatkovic.com/libxml.en.html
ftp://ftp.zlatkovic.com/libxml/64bit/
ftp://ftp.zlatkovic.com/libxml/64bit/
http://www.e7z.org/
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and how this library was compiled, it cannot be statically linked with the MV2 host 
software; in this case, you can build libxml2 from scratch, as described below. 

Macintosh:  

Install MacPorts and use it to install version 2.9.x or later of the libxml2 package. 
To be able to build both 32- and 64-bit executables, also install the 
libxml2+universal variant. 

Linux: 

Install version 2.9.x or later of the libxml2-dev package. For example, in Ubuntu 
14.04 or later, execute “sudo apt-get install libxml2-dev”, or do the equivalent in 
the Ubuntu Software Center. If you want to build a 32-bit application on a 64-bit 
machine, install the 32-bit development versions of this and its supporting 
packages (e.g. in Ubuntu, install “sudo apt-get install libxml2-dev:i386” and 
“…liblzma-dev:i386”). Earlier versions of Ubuntu may install an earlier version of 
libxml2; in this case, you can build libxml2 from scratch, as described below. 

Build from scratch: 

To build the libxml2 library from scratch: 

 Download the libxml2 package from xmlsoft.org and extract it. 

 Install the following tools, in addition to what was described in Section 6-4-5: 

o Windows: Download the ZIP file containing pkgconfig for Windows and 
extract it to your MinGW installation directory, by default “C:\MinGW”. 

o Macintosh: Using MacPorts, install the libtool, pkgconfig, autoconf, 
automake, and lzma packages. 

o Linux (e.g. Ubuntu): Install the autoconf, automake, autotools-dev, libtool, 
and python-dev packages. 

 In a command shell, execute: 

cd 

tar -xzf libxml2-2.x.y.tar.gz 

cd libxml2-2.x.y 

libtoolize –force 

(“glibtoolize” for MacPorts) 

aclocal 

autoheader 

autoconf 

automake --add-missing 

./configure --prefix=<MV2 root path>/MV2/host/libxml 

(--with-lzma=… if lzma is not in the standard library directory). 

make 

sudo make install 

 

https://www.macports.org/
http://xmlsoft.org/index.html
http://win32builder.gnome.org/packages/3.6/pkg-config-dev_0.28-1_win32.zip
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